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Welcome to the latest edition of my monthly Final Cut Studio newsletter for January, 2008.

The goal of this newsletter is to provide information helpful to the professional user 
of Final Cut Pro. This newsletter publishes each month. Past issues are not 
archived. However, key articles are posted on my website for your reference. All 
software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We are 
approaching 200 tutorials to help you get the most out of Final Cut!
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Welcome!

I'm about to jump on a plane and head out to WEVA, Video Forum, and our UK Seminar Tour, so 
this issue may be a bit short.

It's been an exciting month - I wrapped up production on three training videos covering more of 
the applications in Final Cut Studio, our Digital Production BuZZ has shifted into high-gear with 
guests from Apple and Sony, and I'm about to start a new seminar series in the UK.

And, I had a great time co-hosting the Final Cut Pro SuperMeet at MacWorld!

There's lots to talk about, so let's get started.

By the way, if you want to know who's on The BuZZ podcast (which I host) this 
week - then bookmark this page: www.digitalproductionbuzz.com/LiveThisWeek.  
One hour - live - in-depth interviews with the best in the industry. 

[ Go to Top. ] 

Warning: QuickTime 7.4 Breaks After Effects and Premiere Pro

At MacWorld, Apple released QuickTime 7.4 - which had the unintended 
consequence of breaking rendering in After Effects and Premiere Pro.

http://www.larryjordan.biz/store/index.html
http://www.digitalproductionbuzz.com/
http://www.larryjordan.biz/uk
http://www.digitalproductionbuzz.com/LiveThisWeek


While I am sure that Apple is working on a fix, this just illustrates a point I've made before - don't 
upgrade any computer that you rely on for editing until the software has been out for a while. My 
general rule is to wait at least two months.

Upgrading to QuickTime 7.4 provides no new functionality to Final Cut Studio. So, unless you 
really, REALLY need to rent movies on your editing system, upgrading won't get you anything 
new and could, potentially, cause stuff to break.

Here's my basic philosophy: Final Cut Studio, QuickTime and OS X are all joined at the hip. It is 
generally a good rule not to upgrade any computer system that you rely on for editing without 
upgrading all three of these at the same time.

Upgrading QuickTime or OS X by itself doesn't offer any new features to Final Cut Studio. And, 
recently, I've seen more instability with some Final Cut Studio applications running under OS X 
10.5 than 10.4.

I fully expect Apple and the other software vendors will get the kinks out and provide us solid, 
exciting software. the key is to be cautious and not upgrade too soon.

Catherine wrote in to ask:

How does one find out when these products are released? 

Larry replies: A good source of information is Apple's PR website: http://www.apple.com/pr/ and 
Final Cut Pro User Groups around the world: http://fcpugnetwork.org/

[ Go to Top. ] 

Larry's Final Cut Studio Seminars Return to the United Kingdom 

By popular request, we are bringing our highly successful 
PowerUP with Final Cut Studio seminars back to the 
United Kingdom. 

If getting more out of Final Cut is important to you, then these seminars are essential. This is our 
only trip to the UK this year. We will be visiting four cities, with four seminars in each city:

�●     Birmingham, UK -- Feb. 8 & 9
�●     Leeds, UK -- Feb. 4, 5
�●     London, UK -- Feb. 11, 12
�●     Glasgow, Scotland -- Feb. 14, 15

Seminar topics include:

�●     Optimize Your Editing (or, as the Brits say, "Optimise")
�●     Enhance Your Look with Colour Correction
�●     Mastering Final Cut Studio 2

Both Optimize and Mastering have been updated to include all the latest features in the most 
recent updates to Final Cut Studio 2. And, we created an all new seminar exclusively on color 
correction. 

http://www.apple.com/pr/
http://fcpugnetwork.org/
http://www.larryjordan.biz/uk
http://www.larryjordan.biz/sem/2008_uk_agendas.html#1
http://www.larryjordan.biz/sem/2008_uk_agendas.html#2
http://www.larryjordan.biz/sem/2008_uk_agendas.html#3


For editors with tight schedules, we are repeating our most popular Optimize seminar once in the 
morning and once in the evening to make attending even more convenient.

Save 15% if you register to attend more than one seminar.

Save an ADDITIONAL 15% if you register 3 or more people as a group!

Click here to learn more.

Click here to see the agendas.

Click here to register.

These seminars are how I am able to afford to write this newsletter and put as 
much training as I can on the website. Please take the time to attend - you'll be 
very glad you did!

[ Go to Top. ] 

New Alert Message

Keith, from Free Street Films, writes:

Our office opened a copy of Final Cut 6.0.1 this morning and was greeted with the 
error message contained in the attached screen shot.

I'm not kidding!

Larry replies: Keith, even if you made this up, it's still hysterical. Thanks for sending it in.

UPDATE - Jan. 27

DH, of ProVFX, found the solution:

The solution seems to be to check for errant files in System Prefs > Accounts > 
Start up items. 

http://www.larryjordan.biz/sem/2008_uk.html
http://www.larryjordan.biz/sem/2008_uk_agendas.html
https://www.larryjordan.biz/seminarorderform.php
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Larry's Website Now Supports RSS and Better Search 

We just added two new features to our website:

�●     A more comprehensive Search button on the Home page
�●     RSS feeds of all updated articles

If you are trying to find a specific article, it can be darn 
difficult - we just plain have too many. So, do what I do - click 
the Search button in the toolbar of our website.

This is a high-speed way to find all the articles that relate to 
what you're looking for. I use it all the time, and I wrote 
almost everything we have up there.

Then, thanks to our incredible web wizard - (Yay, Srithip!) - we've added an RSS feed for all our 
new articles, press releases, tour dates, teaching ... anything that's new shows up first on RSS.

If you haven't played with RSS, it's easy.

First, make sure Safari is set to be your RSS reader (if you are already using an RSS reader, you 
can skip this step).

Choose Safari > Preferences > RSS tab. Set the Default RSS Reader to Safari.

http://www.larryjordan.biz/cgi-bin/search.cgi
feed://www.larryjordan.biz/feed.xml
feed://www.larryjordan.biz/feed.xml


Then, click the small orange RSS icon in the top left corner of 
our home page.

Voila! All the latest news, delivered to your doorstep!

[ Go to Top. ] 

BRAND NEW! Larry's Final Cut Pro Mousepad 

This is too cool! My very own mousepad!

Almost 30 of my favorite, most well-hidden, most useful Final Cut Pro 
keyboard shortcuts -- all silk screened on an industrial-strength mouse 
pad.

This solves two key problems all editors face:

�●     What do I put under my mouse?
�●     How can I remember any more keyboard shortcuts, when I can't even 
remember what I had for breakfast?

Now there's a solution to both - order yours today! 

[ Go to Top. ] 

Monitoring Your Video

Recently, Matrox updated their MXO monitoring box to support Color and Premiere Pro. At that 
time, I had a conversation with Wayne Andrews, RT and MXO Product Manager for Matrox 
about whether we could use the Matrox MXO for HD video monitoring in a three monitor setup.

Wayne sent me the following response:

If you already have the two graphic cards and are thinking of using the Matrox 
MXO with Color, and three monitors, this should work just like it does with FCP.

You would take you primary graphic card second head and attach the MXO to it, 
this will be your Video out/preview monitor, the primary head, and the second 
graphics card primary head will be Color interface. You will need to set up the 
monitors “layout” in the display control panel from the preference pane. 
 
Now if you have not acquired a second graphic card as of yet, you can look into a 
“cheaper” option by looking at the Matrox Triple Head to Go – http://www.matrox.
com/graphics/en/gxm/support/mac/home.php 
 
The triple head will allow you a larger desktop resolution. There are both digital 
and analog editions. 
 
I personally use this setup at trade shows, NAB and IBC for example, where I 
have three monitors running off of one graphic card, I use the digital one. I take 
the primary head and send that to the TripleHeadToGo, and attach my two FCP UI 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=61
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=61
http://www.matrox.com/video/products/mxo/home.cfm
http://www.matrox.com/graphics/en/gxm/support/mac/home.php
http://www.matrox.com/graphics/en/gxm/support/mac/home.php


monitors; the second head is for the MXO and the preview monitor of FCP.

Larry replies: Thanks, Wayne. While the MXO doesn't make a lot of sense in an SD production 
environment, it is definitely on my short-list of key products for accurately monitoring HD video.

[ Go to Top. ] 

New Video Training on DVD Studio Pro 4 is Released

If you've ever wanted to learn how to use DVD Studio Pro - or learn how 
to use it better - I've got a brand-new training video just for you!

Published in conjunction with Lynda.com, there are over seven hours on 
everything you need to know to make the most of this program.

This walks you through getting your assets ready; creating a simple 
DVD; adding more advanced features such as highlight menus, stories 
and subtitles; and wraps up with scripting and working with 16:9 and HD 
media.

I think you'll find this an excellent addition to your library! 

Click here to learn more, or order a copy!

[ Go to Top. ] 

Larry Is Presenting at WEVA - Las Vegas

I'll be in Las Vegas Jan. 29 - 30, presenting at the Wedding and Event Videographer's Wide 
World of Weddings and Events at PMA08.

Held at the Imperial Palace Hotel and Los Vegas Convention Center, I'll be presenting two 
sessions - one Tuesday night, the next Wednesday morning:

�●     Maximize Your Creativity and Slash Your Editing Time
�●     Final Cut Studio 2: New Features That Will Supercharge Your Productions

If you aren't familiar with WEVA, visit their website - their events have always been a great time 
and I'm looking forward to attending.

[ Go to Top. ] 

Continuing our HDV Discussion

HDV has been a hot topic in several issues of this newsletter and, recently, Professor Uli Plank, 
of Hannover Polytechnical University, in Germany, wrote to clarify some of my statements:

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=60
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=60
http://www.weva.com/convention/
http://www.weva.com/convention/
http://www.weva.com/


In writing on HDV-editing you are using the expression "long GOP" (like many 
other authors do). But may I ask what a short GOP would be? 6 vs. 15 frames? 
After all, everything you wrote applies to JVC's HDV recordings with shorter GOPs 
just as well. 

So, I'm not sure if this expression isn't more confusing than enlightening to our 
readers. After all, in intra-frame compression there is no "group of pictures", not 
even a short one. GOPs only exist in inter-frame compression, and they can have 
different lengths.

I'd suggest using intra-frame vs. inter-frame to keep the compression schemes 
apart.

Regarding the precision of batch capturing HDV: While it's true that this is a critical 
mission, FCP does a remarkable job on it when your drive is in good shape and 
you don't use tapes more than once. From my tests with burnt-in timecode I can 
say that FCP was always dead on regarding the first frame, only the tail was 
longer at times, but that wouldn't cause serious problems.

Further down you wrote: 

"Additionally, HDV supports only two audio channels."  
I'm sorry, but that's not right, Canon for example has models with 4 
channels of audio. But this complicates things even further, since 
other cameras and recorders don't read it and FCP doesn't support 
it in any straightforward fashion.

And then you wrote:

"If you are creating a project that will end up on DVD, shoot HDV, 
then down-convert to DV during capture (out of the camera)." 

From my years of experience with DVD, I wouldn't recommend this for two 
reasons:

�●     As our technical editor already stated, most camcorders don't do a great 
job on down-converting. FCP does it better and MPEG Streamclip is 
excellent at it if you don't have access to a Snell & Willcox [hardware 
converter].

�●     Using DV between HDV and DVD is giving quality away, in particular with 
DV in NTSC with it's 4:1:1 color sub-sampling, since DVD is using 4:2:0 
and the change in sub-sampling makes things even worse. Ingesting HDV 
as ProRes or DVCProHD is much better than this, you can always down-
convert in I/O hardware or later in software and it yields visibly better 
results on the final DVD. Working in DV50 (aka DVCPro-50) would be the 
better alternative if one has FCP 5 only.

For monitoring HD, if one doesn't even have the dough for a Matrox MXO but 
owns a decent HD flat-screen, Blackmagic's Intensity Pro is a viable alternative.

Larry replies: Uli, thanks for writing. Sorry it took me so long to respond.

I agree with most of your comments as I continue to learn more about this format. HDV, XDCAM 
HD, and AVC HD all use compression based on a group of pictures (GOP), and different 
recording frame rates work better at different GOP settings. So the use of inter-frame (using a 
GOP) and intra-frame, make sense to me.



When I wrote this article, I believed that HDV cameras did an acceptable job of converting HDV 
to DV. I've since learned that this is no longer the case. Most HDV cameras do a very poor job of 
down-converting. 

Consequently, I've changed my recommendations to: 

�●     If you are working in an exclusively HDV project, then shoot HDV, edit HDV natively, 
output HDV, then convert it into the format you need for final distribution. 

�●     If you are integrating HDV with other HD formats, convert it into ProRes 422 during 
capture and standardize your editing on ProRes for editing and output.

As always, I enjoy hearing other opinions and will share them in future issues.

[ Go to Top. ] 

Working with the Canon HV20 Camera

Iain Anderson sent this in:

There's a comment at the end of your HDV page, which I have more info on. You wrote: 

UPDATE - Aug. 22, 2007

One thing I noticed with this month's newsletter to do with Justin Ascott's question 
about the Canon HV20:

I have one myself. It is not a progressive frame camera. The sensor records the 
video which is encoded in NTSC or PAL. The Cinema Mode and the HDV 
Progressive frame mode can be used to create a progressive look, i.e., the look of 
24/25p, but the actual signal that is recorded to the tape, and then output when 
you capture in FCP or playback on TV is in fact a standard 60i/50i signal that has 
just been de interlaced. Therefore, to capture whatever footage you have recorded 
with the HV20, you need to use FCPs 1080/50i or 1080/60i preset.

Here's my 2-cents, says Iain: 

The Canon HV20 *does* capture progressive footage, but it stores its footage in 
an interlaced stream. The NTSC model captures 24P but stores it as a 60i stream 
with 3:2 pulldown that should be removed before editing. (This is tedious and time 
consuming -- get the PAL version if you plan to do a lot of progressive work, 
especially if you're in a PAL country!) The PAL model captures 25P stored as a 
50i stream with no pulldown that can be edited directly in FCP. You can capture 
with the 1080p25 Capture Preset, but footage is imported as 1080i50 clips. If you 
want to edit true progressive footage with FCP you'll need to change field 
dominance of captured clips to "None" before editing them into a progressive 
sequence. More details here:

http://funwithstuff.com/therules/2007/10/hv20-pal-1080p25-workflow-solution.html

Some sample images from HV20 progressive footage, shot at home here in 
Australia. Final Cut seems to have issues exporting high quality still images, so 
these have been copied and pasted from QuickTime Player into Photoshop, 
resized from 1440 to 1920 wide, then saved as 100% quality JPEG. Gamma shifts 
may have occurred, and the limitations of the 4:2:0 colour space are evident 

http://www.larryjordan.biz/articles/lj_hdv_learn.html
http://funwithstuff.com/therules/2007/10/hv20-pal-1080p25-workflow-solution.html


around the apple the possum is eating.

http://funwithstuff.com/pics/kookaburra1.jpg 
http://funwithstuff.com/pics/kookaburra2.jpg 
http://funwithstuff.com/pics/possum1.jpg

Larry replies: Iain, thanks for sending this in. 
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Larry is Presenting at Video Forum 2008 - London

No sooner do I finish talking at WEVA than I'm on a plane headed to London to speak at Video 
Forum 2008 on January 31 and February 1.

This marks the start of my UK tour. At Video Forum, I'll be presenting four sessions:

�●     Introduction to Podcasting: Creating Pocket-sized Videos
�●     Audio Mixing with a Soundtrack Pro Master Class
�●     Final Cut Pro 6: Color Correction Master Class
�●     Lessons from Across the Pond - Improving Sales and Marketing Skills

This is my second year at Video Forum -- and a great way to start my UK visit.

If you are anywhere near London, I'd love the chance to meet you there!
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Another Way to Archive Media

Steve MacDonald sent in this technique that he uses for archiving:

Lately, I've found an archiving which seems to work just fine for both standard 
DV media as well as HDV media. Basically, what I do is create a burn folder in 
finder, drag all the media for a specific project from the capture scratch drive to 
this burn folder. (By the way, I do use your 2 drive method for all my FCP projects.)

Next, drag the project folder for this project from your HD drive to this burn folder. 
As you well know these are Alias files at this point. I rename these burn folders for 
clarity, one called ABC project folder, the other ABC media folder. Now, if you 
double click this folder you'll see a small burn icon in the upper right, double click 
that and it will give you a total file size. My test for this method was a short 2 
minute HDV project with a burn folder size of 1.09GB. In finder > file > burn disc. 
Once that burn is complete you can trash all the media files for that project from 
the scratch drive, then go in FCP and delete the project itself. 

Re-mount the burn disc if you've ejected it. On your 2nd drive, > final cut pro 
documents > capture scratch, create a new folder and title it. Now open the burn 
disc and drag all the media files to this new capture scratch folder. Launch the 
FCP project from the ABC project folder on the burn disc. You'll see all that media 

http://funwithstuff.com/pics/kookaburra1.jpg
http://funwithstuff.com/pics/kookaburra2.jpg
http://funwithstuff.com/pics/possum1.jpg
http://www.broadcastvideoforum.co.uk/
http://www.broadcastvideoforum.co.uk/
http://www.larryjordan.biz/uk


off-line, now you just re-link it to the new capture scratch folder and voila. 

The beauty of this is you don't have to re-batch capture your footage from tape 
and this media is on DVD for archiving. Of course, larger project would require 
multiple disc burns for your media. Sorry for the book length e-mail.

Larry replies: Your system works great as long as your media files are small. However, I 
STRONGLY recommend AGAINST using dual-layer DVD disks, as they are notoriously 
unreliable for playback on different machines. This means that you are limited to single-layer 
DVDs which only hold 4.3 GB of material when burned. 

This works out to about 20 minutes of HDV material. So, if you had 50 hours of source footage, 
this would require 150 DVDs and more than two weeks to burn. 

Which is not particularly practical.
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Creating Favorite Effects

Charlie Wilson, from BBC-America, writes

I am in the process of overhauling the edit system at CBS for Face the Nation 
which is now getting a new home right next to the control room. There is one thing 
in AVID that I have not been able to figure out an equivalent in FCP. In AVID when 
you need a group of pictures to be zoomed in to fit a graphic, there are several 
effect tabs, picture in picture, or 3D Effect that you can save in your FX bin. What I 
have been doing is saving a dummy clip out of the active area of the timeline, and 
copy / paste attributes. Is there a way to save zoom and position as a effect tab? I 
have tried dragging the clip or the motion tab.

Larry replies: Charlie, Final Cut has what are called Favorite Effects and Favorite Motions. They 
are stored in the Favorites folder in the Effects tab in the Browser.

To create a Favorite Effects (filters) or Favorite Motion (motion tab):

1.  Create the effect you like
2.  Make sure the clip is loaded into the Viewer and that the Viewer is selected
3.  To create a Favorite Effect, make sure the Filter tab is selected in the Viewer, then 

choose Effects > Make Favorite Effect.



4.  To create a Favorite Motion, make sure the Motion tab is selected in the Viewer, then 
choose Effects > Make Favorite Motion.

You can create an unlimited number of favorites, plus, the first five in each category are 
automatically assigned keyboard shortcuts.

Keep in mind that all favorites are stored in your preference files. Which means when you trash 
your preferences, your favorites will also be erased.

Here's an article that tells you more.

And here's an article that is a VERY cool tip on how to backup your Favorites folder.
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Editing on a UVW-1800 Betacam Deck

Bob Flood writes:

I have to call you on a recent statement you made in your latest newsletter:

"What you need to do is find a deck that supports inserting. For 
instance, in DV, the Sony DSR-1500 does, but the DSR-25 does 
not. In Betacam, the UVW series does not, but the PVW series 
does."

The UVW 1800 Betacam SP VTR DOES support insert editing, just not from a 
front panel control like the BVW and PVW series.

We own a UVW 1800, and that's usually how I edit to tape.

Originally the UVW was developed for computer animators and such, and to keep 
the cost down Sony did not install an internal editor. Any computer or external edit 
controller that uses the full Sony 9 pin RS422 protocol, such as FCP, can initiate 
insert edits of any flavor: A1, A2, or Video.  
Of course the usual rules apply: the tape has to be "blacked" [or pre-recorded] 
with timecode and video of some kind i.e. black or system bars, and if you are like 
me, who has an AFM Audio Modification on my UVW, you wont be able to insert 
AFM Audio separately of Video, as the two are multiplexed together. 
the deck also supports full assemble editing as well.

BTW, I think there is even a hack to enable Time Code track editing, if you ever 
need to re stripe time code onto a tape. It has been a while since I used it, and it 
may not be "controller agnostic", but if you Google it i think you can still find it.

Larry replies: Bob, thanks for this update. I owned a UVW-1800 for years and never could figure 
out how to get it to insert edit. I'm glad to know this trick exists.

Bob replied:

I hope it helps someone. judging by all the UVW and PVW machines on ebay, it 
seems mastering on SP is becoming an anachronism

http://larryjordan.biz/articles/lj_fave_filter.html
http://larryjordan.biz/articles/lj_saving_favorites.html


I wish Sony and Panasonic would get their heads [ um, together ] and make some 
machines like the UVW for HDCAM and DVCPROHD.
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Avoiding a Range War

Jerry MacKay, of Full Circle Studios, writes:

I got a 24P question: am I the only one who thinks that 24P shot on video looks 
stuttery?

I recently DP'd a short film and shot it with the Panasonic HVX200 in 1080i 24PA 
mode. The film was edited in Final Cut in a 24P timeline, and authored with 
DVDSP to a DVD. Looking at the film both in Final Cut and off the DVD, the 
footage is stuttery, almost like it's playing at 15 fps (at least to my eye it looks like 
that).

I also recently directed my own film, which we shot it with the Sony Z1U in 1080 
60i. I edited in FCP and used Compressor to deinterlace the final films into 30P, 
and they look great. I think they have a great "shot on film" look, but without the 
stutter of 24P.

Everyone seems to love 24P for the film look, but I've never seen a film on 
television that stutters like this. What's going on here? Is it...

A. Shooting in 1080 is the problem (which is why many people shoot 720P). 
B. The footage is being edited in Final Cut the wrong way. 
C. Compressor is not encoding the right way. 
D. DVDSP is messing something up. 
E. Hollywood post-production houses have multi-million dollar converters to make 
24P look good on TV. 
F. Everyone who likes 24P is crazy. 
G. I am crazy.

Larry replies: Jerry, even attempting to answer your last two questions could cause a range war.

Here's my take. I don't think there's any magic in 24 fps material. For me, a better indicator for 
the "film look" is a progressive image, with good lighting and whites that aren't blown out.

For example, I can see a slight stutter in 24 fps film - which I don't in 30 fps material. 

As for the rest of your questions, while it is entirely possible for settings to be incorrect in FCP, 
DVD SP, or Compressor, when used properly your video should come out looking the same as it 
was shot.
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I Wish Final Cut Pro Would...



Gary Freedline, of Video Keepsakes of Beverly Hills, sent me a LONG email detailing his four 
biggest concerns about what Final Cut should do, but doesn't.

In reading it, I realized that Final Cut does, in fact, do most of them, but not in an obvious way. 
So, I'm reprinting his questions with my answers.

Question 1

The way FCP handles adjusting clips that change speed by pushing everything 
down the timeline. It should ask before messing with the timeline.

Larry replies: There are two speed changes in Final Cut: A constant speed change and a 
variable speed change. 

A constant speed change always changes the duration of the clip, the variable speed change 
does not.

A constant speed change plays every frame in a clip from In to Out. A variable speed change 
may play more frames, or less.

However, there's a VERY cool workaround that solves this that, um, I just discovered I haven't 
written up for the web yet. Hmm... see the next article, then.

Question 2

There seems to be no easy way to know if a clip or section (subclip) was used or 
not.

Larry replies: Yup, there isn't. I thought I could use labels, but while labeling a clip in the Browser 
causes the same label to show up in the timeline, adding labels in the Timeline does not label the 
master clip in the Browser.

UPDATE - Jan. 27

David Ransley suggested this solution:

There is a way to know if a clip was used in a sequence. Highlight a sequence(s) 
in the Browser and choose Find > Unused Media. 

Larry replies: Yup. That would list all clips that are not used. However, if only one frame from a 
clip is in the timeline, the entire clip is flagged as used. 

Question 3

It doesn’t seem that there is a way to copy a clip from a different sequence and 
place it on any track in another sequence.

Larry replies: Piece o' cake.

You are correct. By DEFAULT, FCP pastes a clip on the same track it was copied from. But, you 
can change this using the Auto-Select lights.

Here's an article that describes how. It was written back when Apple was having a hard time 
figuring out how to do this, but Apple finally standardized Auto-select behavior in FCP 4.5. It has 

http://larryjordan.biz/articles/lj_auto_select.html


  
  
  
  
  
  
  
  
  
  

behaved the same ever since.

Question 4

The most common dissolve or transition is a 30 frame centered dissolve, there is 
no easy way to jump 15 frames on the timeline.

Larry replies: You are correct, the default duration for a transition is one second (30 frames in 
NTSC, 25 frames in PAL).

You can change the default transition easily, however, and this article shows you how. And, if 
you hold the Shift key down while pressing the Left or Right arrows, you'll move the playhead in 
one-second increments.

UPDATE - Jan. 27

Tom Wolsky writes:

With nothing selected in the timeline press 15 and return to move forward, or -15 
and return t move backwards 15 frames. 

Larry replies: Sheesh! I totally forgot about moving around using Timecode! To do so, type the 
number of seconds or frames you want to move (300 would be three seconds, 15 would be 15 
frames) and press Enter on your keypad. The playhead jumps right if the number is positive and 
left if the number is negative. 

I use this ALL the time and I totally forgot. Thanks, Tom. 

[ Go to Top. ] 

A Better Way to Change the Speed of A Clip

The problem with adding a constant speed change to a clip is that it always changes duration 
when you change the speed of a clip, thereby pushing everything out of whack downstream.

Here's a very slick technique that prevents that problem.

But, first, a bit of background. By definition, if you change the speed of a clip it MUST change 
duration if it is going to play every frame from the In to the Out.

However, if you are willing to not play every frame, then this technique works perfectly. Here's 
how:

1.  Put your playhead into the clip who's speed you want to change. 
 

 
 

http://larryjordan.biz/articles/lj_default_01.html


2.  Position your playhead on the frames you want to keep. Those frames that are furthest 
from the playhead will be lost in the speed change (assuming you slow the clip down. If 
you speed it up, frames prior to the In or after the Out will be added to the clip.

3.  (Here's the secret trick!) Press Option+Command+F. This loads the source clip into the 
Viewer (notice there are no sprocket holes in the playhead scrubber bar at the bottom of 
the Viewer). This acts like a Match Frame, but without setting an In or an Out. 
 

 
 

4.  Select the Viewer
5.  Choose Modify > Speed and change the speed of the clip. In this example, I'm slowing it 

to 50% normal speed. 
 

 
 

6.  Without moving the playhead in the Viewer or the Timeline, drag the clip from the Viewer 
to the Canvas and drop it on top of Replace edit. 
 



 
 

7.  POOF! Your timeline clip has changed speed without changing duration (see the green 
render bar at the top of the clip?)! 
 

I use this trick frequently and still marvel at how well it works.

[ Go to Top. ] 

Problems with Speed-changed Clips in Color

I got the following message from Alexis Van Hurkman, who writes about Color for Edit Well. 
Alexis writes:

If you are having problems rendering clips in Color, it may be because you have a 
speed effect applied to the clip. I generally recommend sending all speed effects 
from FCP to Motion to render using Motion's whiffy optical image flow analysis, 
and then rendering as a self-contained movie and reinserting back into the 
originating FCP project before sending to Color. That way you get high quality 
motion, and the FCP to Color round trip becomes easier.

Larry replies: Thanks, Alexis. And for anyone interested in learn more about Color, be sure to 
read Alexis' outstanding series in Edit Well.

[ Go to Top. ] 

Reader Mail

http://www.peachpit.com/editwell


UPDATE - Jan. 27

Ben Balser sent me a detailed email with comments and answers to many of these questions. 
Click here to read it in its entirety.

Viewing Video in the Viewer

Marty Nowak writes:

Why in God's green earth does the video in the viewer always look perfect and the 
video in the canvas always looks [awful], comparatively. It could be graphics, 
video, whatever!

Is this a bug? Me? Or just a dumb FCP thing no brainiac has yet to figure out.

Larry replies: Marty, none of the above.

The video in the Viewer is displayed in its source resolution. The video in the Canvas is 
displayed based upon the codec you've selected for the Timeline.

[ Go to Top. ] 

Watching Video on the Computer Screen

Anneli Tofte, of Stockhom, Sweden, writes:

This is a very general question but I hope it will find it's way into the newsletter.

I am working with DV CAM, PAL, and editing/outputting in the same format. More 
and more of my clients wants to have files, not tapes or DVD:s, and show the films 
on computers, either on screen or with projectors. And I think the result is 
disappointing, really.

So, my question is: which is the best way to handle DV CAM video that is to be 
viewed on computer screens?

Larry replies: Try Photo-JPEG -- small files, very high quality, can be played on virtually any 
computer.

[ Go to Top. ] 

Preventing Insanity

Dave Pastor writes:

I ordered another one of your DVDs as a present to myself. I have your DVD on 

http://www.larryjordan.biz/nxltrs/nxltr_42_cmnts.html


Sound Track Pro Essential Training. Your DVDs are really great. 

My problem du jour is that I can hardly ever send a clip to SoundTrack Pro from 
Final Cut 5 as an "Audio File Project" I never get that option. I only have the 
options for "Multitrack Project" or "Script". This is driving me insane.

Larry replies: Dave, try to keep it together...

You can only send single clips to an Audio File project. This means either mono, or stereo, but 
NOT dual-channel mono clips. If the menu choice is grayed out, it's because you are trying to 
send too many clips. 

[ Go to Top. ] 

Importing Subtitles to DVD SP Doesn't Work

Dave Victorson writes:

Here's a question for a pro: I use a third party vendor to create the subtitles. They 
import just fine when the video track contains a Quicktime Video (imported into 
DVD SP). I get an error message when the video track contains a .m2v video 
(imported into DVD SP).

Here is the exact error message.

Import Subtitle File

No corresponding subtitles found. The video asset timecode may 
not correspond with the timecode specified for the subtitles in the 
import file or the file is invalid.

Any ideas?

Larry replies: Yup. The problem is that importing subtitles or markers into DVD Studio Pro 
requires a timecode reference. When you export out of Final Cut, your timecode starts at hour 1. 
When you compress an MPEG-2 file, by default, the timecode starts at hour 0. In other words, 
the timecodes don't match, which breaks the import process.

To fix this, either change the timecode references in the subtitle text file, or change the starting 
timecode in Compressor before you compress the file.

[ Go to Top. ] 

When's the Best Time to Convert PAL to NTSC?

Anders Moden, from Stockholm, Sweden, writes:

First, I'd like to thank you so, so much for your wonderful tutorials at Lynda.com.

I am living in Sweden, and so all our filming is in PAL. I am making an instructional 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?manufacturers_id=10&products_id=37


DVD for magicians, and as such, the project is fairly secret.

Now, at the end, this DVD needs to be NTSC. When do I change it from PAL to 
NTSC? I am almost done editing. Should I change the sequence preset to NTSC 
in FCP, should I send to compressor and change to NTSC? Should I save as a QT 
and change it in Compressor? Or should I do it another way?

I am using PAL video, PAL encoded LiveType projects, and Photoshop files.

Larry replies: Anders, thanks for writing and the very kind words.

You should change your video when the project is complete. Shoot PAL, edit PAL, output a PAL 
self-contained QuickTime movie. At this point, using either Compressor or Graeme Nattress's 
Standard Converter, or a Teranex hardware box, convert it from PAL DV to NTSC DV.

Then, in a second step, convert it from NTSC DV to NTSC MPEG-2. This two step process will 
take a bit longer, but the finished results will look better.

[ Go to Top. ] 

Monitoring Audio During Capture

Emily Rumsey, from Madison, Wisconsin, writes:

I'm logging and capturing on a laptop with no external monitor, using a DVCAM 
deck. The log & capture window registers sound on the meters but I can't hear it. 
Once out of the L&C window you can hear clips fine.

Where can I set the L&C to hear audio while logging?

Larry replies: Emily, monitoring during capture showed up with Final Cut Pro 5. 

Open the Log & Capture window and make sure Preview is checked in the Clip Settings window. 
This turns on audio play-through during capture.



UPDATE - Jan. 27

Michael Grenadier sent in the following caution:

I think this is a dangerous recommendation to make without the following caveat: 
Monitoring the audio during capture adds to system overhead. Occasionally this 
will create problems in the captured file usually manifested as random clicking. I 
saw this way back in fcp1. Since in my opinion, a good fcp system includes an 
audio patchbay, it should be possible to monitor your audio directly of the camera 
or deck. So I haven't left myself vulnerable to this problem in a long time. I figured 
this wouldn't be a problem with faster mac's and newer software, however recently 
someone recently posted on the Apple FCP forum a problem with random clicking 
in captured media that was not there in the original material. Sure enough this was 
the cause of the problem. 

[ Go to Top. ] 

Misbehaving Audio Red Rubber Bands

Bob Cusumano writes:

Why is it every time I click on an audio rubber band to place a key frame, it 
automatically lowers slightly. Try it and tell me what you think. Can you let Apple 
know about this and ask them to change it? Thanks.

Larry replies: Consider them told. However, I don't generally have this problem. I tend to use the 
Selection (arrow) tool and press the Option key to create keyframes.

Or, you can always use the Pen tool (press P).

UPDATE - Jan. 27



Tom Wolsky writes:

This has been there since v1. I think I wrote about it in my first book. I believe it's 
related to track height. If the track height is a bit larger it doesn't seem to happen 
so often. The problem is very prevalent on laptops. 

Larry replies: Thanks, Tom, adjusting track height would definitely help. 

[ Go to Top. ] 

More on M/S Mikes

A while ago, I wrote an article on using M/S microphones with Final Cut. (You can read it here.)

Initially, I thought there would not be a solution to using them in Final Cut. But, first Andrew 
Commiskey sent in one way to use them, then Ben Scott sent in this:

There is filter in soundtrack pro 2 called direction mixer has a tick box for m/s 
decoding along with a slider for spread which is the s channel

one of the fantastic tips chris gave for the weekend was that 2 omni clip mics on a 
coat hanger is one of his favourite pieces of kit for recording stereo. obviously this 
isn't m/s but it is really nice idea to pass onto others

I see you are comingto Britain in the new year, maybe I see you at Video Forum 
again.

Larry replies: Ben, thanks for writing. And see you next week at Video Forum!

[ Go to Top. ] 

More Audio Questions

Trent Anderson writes:

Thanks always for your great newsletter, and the last issue of Edit Well. You are 
the best. May I ask a couple of tech questions about sound?

1) I am editing in FCP 6, and have two on-camera interviews. One was done 
inside a home, and the background is kind of like echoing...his voice is 
fine, but there is that kind of hollow, echo sound. Is there a filter that might help 
remove that?

2) The other was done outdoors, and again, his voice is fine, especially when I 
apply the Modify/Audio/Apply Normalization Gain. However, there 
is some outdoor, background, hissing, buzzing ambient sound. Any suggestions 
for a filter to help reduce or remove this?

Larry replies: Thanks for the kind words.

http://larryjordan.biz/articles/lj_MS_audio.html


Regarding question 1: Once you have echoes in your audio it is virtually impossible to remove 
them. The CIA may have something, but they haven't shared it with Apple.

Regarding question 2: Soundtrack Pro has an excellent noise reduction process that I 
recommend highly. I just wrote an article on it today for the next Editors' Guild magazine. As well, 
I cover it in my Soundtrack Pro training DVD. (I don't think I have an article on it for the website, 
yet, though.)

Other noise filters you can consider include SoundSoap from Bias Inc, and DINR for ProTools.

[ Go to Top. ] 

Tips on Motion

Thomas Berglund sent in the following:

I see that someone asked about motion tracking in Motion 3, in your recent 
newsletter.

Here are two great tutorials on that subject: 
http://motionsmarts.com/tutorials/matchmove1/mm1.html 
http://www.pixelcorps.tv/macbreak86

As always... there are a lot of great resources for Motion at Mark Spencer's 
website: http://applemotion.net/

Larry replies: I've had the pleasure of working with Mark as a contributing editor for Edit Well for 
a while now. His knowledge of Motion is amazing and I encourage you to visit his site.

[ Go to Top. ] 

Working with P2 Media

David Naylor, of the DVD Group, writes:

Hey, have you had much experience with P2 media? Is it true you have to convert 
everything to QuickTime before you can edit in FCP?

Larry replies: Yes, but that's not necessarily a bad thing. Final Cut is a QuickTime editor. This 
means that any video it edits needs to be in a QuickTime format.

Media shot by a P2 camera is in MXF format. So, on ingest, FCP converts it from MXF to 
QuickTime. There is no loss of quality during this conversion, but there is a loss of some of the 
MXF metadata, which is database information captured during the shoot.

The nice thing about this process is that it happens much faster than real-time, and that if you 
ever need to recapture the media, Final Cut tracks the P2 source file, which makes recapture 
easy -- as long as you have the source file accessible on your hard drive.

[ Go to Top. ] 

http://motionsmarts.com/tutorials/matchmove1/mm1.html
http://www.pixelcorps.tv/macbreak86
http://applemotion.net/
http://www.peachpit.com/editwell


Working with Multiclips

Anthoy Mournian writes:

I enjoy your newsletter very much, and it prompts me to ask:

I shot two rolls of videotape. The first was on a Canon GL-1 (SD, anamorphic 720-
480). The second was on a Sony HDR-FX1 (HD 1920-)

Both were brought into FCP 6.0. I want to make a multiclip, but each time I get the 
message that they are not the frame size, so no multiclip is possible.

Can I do it?

Larry replies: No. In order to create a multiclip all source clips need to be the same video format, 
same frame size, same frame rate. In other words, technically identical. 

In your case, you would need to convert one of your formats to match the other, then you can 
create a multiclip.

[ Go to Top. ] 

When to Color Correct

David Tindale writes:

My name is David Tindale and I work for a small media company in Broome, 
Western Australia. We've recently upgraded our old PD150 cameras for the Z1P 
HDV. I was talking to one of our directors the other day as we went over some 
footage and he suggested that HD is designed to be colour corrected in post. 
Whereas SD footage is only corrected if necessary. I'd be grateful if you or one of 
your subscribers could shed some light on this for me.

Thanks and I look forward to each issue, always something new and engaging.

Larry replies: Your director is, ah, confused. ALL video can benefit from color correction. 
However, some high-end HD formats, such as the Viper camera, captures video in a high-quality 
RGB format which tends to have a green tinge, but contains much more accurate color 
information for more precise color correction. Your director may be thinking of this.

However, most HD formats try to get as realistic a color as possible. Still, whether you are 
looking at SD or HD, most shots can be improved with color or exposure correction.

[ Go to Top. ] 

Creating an HD-DVD



Christina Cassidy writes:

I need some tech help re: making a DVD from FCP.

I shot my video using my HDV camera, but shot it DV 16:9. When I log and 
captured it in FCP, I got a 16:9 image.

After putting together my sequence (in 16:9) I exported it using Quick Time Movie. 
I imported my assets into DVD Studio Pro. When I did so, the graphical icon for 
the track immediately shifted from 16:9 to 4:3. My image looked squished. I went 
ahead and burned the DVD. Of course, my image was squished. I then tried to 
change the size of the pixels, but it didn't change anything. The image on the DVD 
was a 4:3 image.

What, pray tell, is my pea brain doing wrong? Thanks for your help.

Larry replies: First, I am assuming you want to make an HD-DVD from your HDV footage. 
Because if you need to create an SD-DVD, you'll need to down-convert and compress your 
footage in Compressor instead.

I'm also assuming you want to create an HD-DVD, as DVD Studio Pro does not currently support 
burning to a Blu-Ray disc.

Since HDV is already compressed into MPEG-2 HD, which is one of two acceptable formats for 
an HD-DVD, you don't need to compress anything once the file gets into DVD Studio Pro.

However, before you start creating new menus and tracks, change your DVD SP preferences to 
make sure it is expecting HD 16:9 video. There are three preferences you need to change:

* General

* Project 



* Simulator 
 

In both the Project and Simulator, you'll need to specify your video format. My suspicion is that 



one of these were set incorrectly, resulting in squished video.

Remember, like Final Cut, you need to change preferences BEFORE you create a new project, 
track, or sequence.

[ Go to Top. ] 

What Do the Color Lines Mean?

Sérgio Pedro writes:

There's a photo attached to this mail from Final Cut Timeline, the only thing i wanted to now is 
the meaning of the colored bars at the bottom of the clip.

Larry replies: Sérgio, thanks for writing! 

The color lines indicate where there are duplicate frames - portions of a shot that are being using 
more than once in your timeline.

This was introduced by Apple in FCP HD, and designed to help film editors avoid using the same 
film negative frame more than once.

You turn this on or off at the bottom of the timeline, or from Sequence > Settings > Timeline tab 
and unchecking Show Duplicate Frames.

[ Go to Top. ] 



A Reader Request

Todd Mallasch asks:

I'd like to use a computer monitor to watch my HD video. I've heard about 
Veescope Live, HD Monitor, and Scopebox, but don't know how well they work.

Do you have an opinion?

Larry replies: For monitoring HD material on a computer display, you need a device that displays 
the correct color space (Y'CrCb), the correct gamma setting (gray-scale), full-raster (every pixel), 
and with interlacing.

A standard HD video monitor will do this, but at a great cost.

The Matrox MXO does this, as well, at much lower cost.

However, these three software I don't know well enough to answer your question. If a reader 
shares their opinion, I'm happy to pass it along.

[ Go to Top. ] 

Using MPEG-2 Video in Final Cut Pro

Henrik Björlin, of Stockholm, Sweden, writes:

I’m doing a project where we will have to use already compressed material from 
DVDs (also commercial DVDs but totally legal though, we will have all the rights 
cleared) because of timeframe and costs.

I have a friend who says it is possible to edit MPEG-2 directly in the timeline of 
FCP. Is it true? I will have to export it to be played on some kind of media player in 
MPEG-2 format. I would of course want to avoid to recompress it again...

Larry replies: Final Cut really does not like compressed video. It would be better to convert this 
into DV using either DVDxDV or MPEG Streamclip, then edit the resulting file.

UPDATE - Jan. 27

Lars Hillejan responded:

I really enjoy your training on Lynda.com. However, one thing I don´t like, is that 
you seem to keep pushing the DV format. I just read your January issue and you 
recommended to convert DVD material to DV for editing. 

I don´t think that´s a good idea. In my experience you get much better results from 
the Photo JPEG 75% setting (of course you have to tweak the real time enabler 
file, otherwise editing is a real pain). 

And now that there´s ProRes around, I really wouldn´t use that (Photo JPEG) 

http://www.dvdxdv.com/NewFolderLookSite/VeeScope/Products/VeescopeLive.try.htm
http://www.redlightningsoftware.com/Home.html
http://www.scopebox.com/
http://www.matrox.com/video/products/mxo/home.cfm


either. For me, ProRes is the new Photo JPEG and I think with the increasing 
power of the maschines and the increasing performance and size of hard drives, 
there is really no need to use DV anymore (unless you have it on tape). 

Oh and you also say, Final Cut doesn´t like compressed video. Speaking of 
MPEG-2, I know what you mean, but this might be a little confusing. 

Larry replies: An excellent opinion - I'll add it to the newsletter.

Photo-JPEG is amazing - the only problem with ProRes is that files are 5-6 times bigger than DV, 
which causes a problem for some. Also, since DV is higher quality than DVD I haven't seen the 
need to get even higher quality. But you have a good point.

And you are correct, I should clarify that Final Cut does not like video that has been compressed 
for the web or DVD. Since most video files are compressed in some way, my blanket statement 
could be somewhat confusing.

[ Go to Top. ] 

Another Faster Way to Record

Bob Gobeille writes:

I don't know if you are interested in Linux, but I don't have a laptop running final 
cut (see A Faster Way to Record). I do have a linux laptop and have used an open 
source program called "dvgrab" (see http://www.kinodv.org/) that will also record 
Firewire DV. Like your other reader, this allowed me to record to my laptop hard 
drive (with a tape backup that I never needed). I would have the extra step of 
transferring the video to my mac pro for editing but this is fast (on a Gb network).

Keep up the good work!

Larry replies: While I am not a Linux user, I am a big fan of getting work done faster. Thanks for 
sending this in!

[ Go to Top. ] 

Wrap-up

Well, I've only got 41 more messages until I'm caught up with my newsletter backlog. Sorry some 
of these questions have taken so long to publish. (Sigh...)

In the meantime, please continue sending me your comments and questions. I love hearing from 
you and enjoy the conversations that develop around these stories.

Also, please take a few minutes, and: 

1.  Register for one of our UK seminars.
2.  Visit our store and buy something.

http://www.kinodv.org/
http://larryjordan.biz/uk
http://larryjordan.biz/app_bin/Store/catalog/


Your support for our seminars and products allows me to keep publishing this newsletter. 

Thanks for all your comments and questions. I love hearing from you because when we share 
our ideas and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2008 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page or website articles are welcome and don't require prior 
permission. 
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